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Introduction

There are several ways to repurpose content from your existing Google Slide or PowerPoint
presentations into a SoftChalk lesson.

The quickest way to add content from a slideshow presentation is to embed the content
within a SoftChalk lesson - see the sections:

e Embed a Google Slide Presentation in a SoftChalk Lesson

e Convert a PowerPoint Presentation to a Google Slide Presentation and Embed It in a
SoftChalk Lesson

e Embed a PowerPoint® for the Web Presentation in a SoftChalk Lesson

Many instructors will break up a long presentation with lots of slides into smaller
presentations, embed each presentation and then add SoftChalk interactives to make the
content engaging. (These interactives can be added from within SoftChalk Create or Create

Online. For more details, see the SoftChalk Cloud Quick Start Guide or the SoftChalk Video
Tutorials.)

Some instructors prefer to put content (images or text) from individual slides into their
SoftChalk lessons and then add interactives - see the main topic Additional Methods for
Putting PowerPoint® content into SoftChalk Lessons.

PowerPoint and Google Slides Integration Guide Web Link

The URL for this guide is below. As we update this guide, the URL will remain the same.
(You may want to bookmark this link in your web browser.)

https://softchalk.atlassian.net/wiki/download/attachments/129532299/createquide.p
df?api=v2
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https://softchalk.com/cloud/sample-activities
https://softchalk.atlassian.net/wiki/download/attachments/129237016/quickstartguide.pdf?api=v2
https://softchalk.com/support/training/video-tutorials
https://softchalk.com/support/training/video-tutorials
https://softchalk.atlassian.net/wiki/download/attachments/129532299/createguide.p%20df?api=v2
https://softchalk.atlassian.net/wiki/download/attachments/129532299/createguide.p%20df?api=v2

Embed a Google Slide Presentation in a SoftChalk Lesson
Copy the Google Slide Embed Code
1. Open a presentation in Google Slides.

2. Select File and select Publish to the Web.
File |Edit View Insert Format

Share

New >
Open Ctrl+0
Import slides

Make a copy E
Download E

Email as attachment
Make available offline
Version history "
Rename

5 Move

£ Add shortcut to Drive

B Move to trash

Publish to the web

3. Click Publish (in case you do not see Publish, you may need to enlarge your
screen). At the screen Are you sure you want to publish this selection, click OK.
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4. Click Embed and copy the Embed code.
Publish to the web X

This document is published to the web

Make your content visible to anyone by publishing it to the web. You can link to
or embed your document. Learn more

Link Embed

Slide size: Auto-advance slides:
Medium (960x569) ~ every 3 seconds (default) ~

Start slideshow as soon as the player loads

Restart the slideshow after the last slide [P SRS

YDNMikdJKZIRSBJIfDdV1c2TgmiWiihEyJoHVYo10TBsRMd-
c3Deu0GIHi/embed?stari=false&loop=false&delayms=3000"
rameborder="0" width="960" height="569" allowfullscreen="true"
mozallowfullscreen="irue" webkitallowfullscreen="true"></iframe:

Add the Embed Code in Create Online

|
1. Click on the Widget icon i in the Create Online toolbar.
2. Give the Widget a name and right-click to Paste the copied embed code.

3. Click OK.

Insert Widget X

Widget || How To

Mame

Description

Widget HTML

oK Cancel 4
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Add the Embed Code in SoftChalk Create
1. Go to the Insert menu in SoftChalk Create. Choose Widget.

2. Give the Widget a name and click Paste HTML.

€4 Insert Widget ped

Widget How To

Widget

Mame:

Description: ~

Widget HTML: S

Paste HTML Clear HTML
Cancel

3. Click OK to insert the Widget into your lesson. You will see the Widget placeholder in
Create. When you Save and Preview the lesson, you will see the Google Slides
appear within the Widget frame.

You can see an example of Google Slides presentations embedded in SoftChalk’s 2019 First
Place Lesson Challenge Winner in an online orientation lesson on pages 1 and 3.

For other sample SoftChalk lessons, see SoftChalk Sample Lessons.
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https://softchalkcloud.com/lesson/serve/uaXQy8WBprL0i1/html?_ga=2.77498199.394297963.1598385523-2004579581.1587131723
https://softchalk.com/our-customers/sample-lessons-full

Convert a PowerPoint Presentation to a Google Slide
Presentation and Embed It in a SoftChalk Lesson

1. Go to Google Drive.

2. Select New in the upper left-hand corner of the screen.

3. Select Google Slides.

L Drive
I— New

Folder

File upload
Folder upload

Google Docs

8
Google Sheets

Google Slides

More

>

4. In a new Presentation, select File and then Import Slides.

+ - Share

New

Open

s Untitled presentation
File | Edit View

Insert Fortr

| 2

Ctrl+0

4 Import slides

Download

Make a copy

|
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5. Click Upload and drag over a file or Select a file from your device.

6. Once you have uploaded your PowerPoint presentation, click on All (or only select
slides from the PowerPoint file) next to Select slides.

7. Click Import slides (if you do not see Import slides, you may need to expand your

window).

Import slides

Eye Diseases

Select slides:|All|None

Eye Diseases

Normal

Cataract

e

Glaucoma

\

Myopia

i

Back

5 slides selected

Cancel

/' Keep original theme

Import slides

8. Follow the steps of the previous section Embed a Google Slide Presentation in a

SoftChalk Lesson.
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Embed a PowerPoint® for the Web Presentation in a SoftChalk
Lesson

1. Save your presentation to OneDrive.com. (Storing the presentation to a public folder
online is what allows you to embed it on a web page.)

2. Open your presentation in PowerPoint for the web. On the File tab of the Ribbon,
click Share, and then click Embed.

3. To create the HTML code to embed your file in the web page, click Generate.

4. In the Embed box, under Dimensions, select the correct dimensions.

5. Under Embed Code, right-click the code, click Copy, and then click Close.
Add the Embed Code in Create Online

n
1. Click on the Widget icon it in the Create Online toolbar.

2. Give the Widget a name and right-click to Paste the copied embed code.

3. Click OK.

Insert Widget X
Widget || How To

Name

Description

Widget HTML

0K Cancel p

SoftChalk LLC copyright 2022 SoftChalk PowerPoint and Google Slides Integration Guide page 9


https://onedrive.live.com/
https://office.live.com/start/PowerPoint.aspx

Add the Embed Code in SoftChalk Create
1. Go to the Insert menu in SoftChalk Create. Choose Widget.

2. Give the Widget a name and click Paste HTML.

g4 Insert Widget x

Widget How To

Widget
Name:
Description: A
v
Widget HTML: A

Paste HTML Clear HTML

Cancel

3. Click OK to insert the Widget into your lesson. You will see the Widget placeholder in
Create. When you Save and Preview the lesson, you will see the Google Slides
appear within the Widget frame.

4. Go to Insert / Widget.

5. Give the Widget a name and click Paste HTML.

g8 Insert Widget X

Widget How To

Widget

Name:

Description: s

Widget HTML: Py

Paste HTML Clear HTML

oK Cancel

6. Click OK to insert the Widget into your lesson. You will see the Widget placeholder in
Create. When you Save and Preview the lesson, you will see the Google Slides
appear within the Widget frame.
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Additional Methods for Putting PowerPoint Content into
SoftChalk Lessons

Save PowerPoint® File as Images and Place Images into the SoftChalk
Slideshow Activity

You can save your PowerPoint® file as a series of images and import these images into
SoftChalk as a Slideshow Activity (or you can insert each image individually into a SoftChalk
lesson).

If you have PowerPoint® 2007, you can do the following:

1.

2.

7.

Within PowerPoint® 2007, open a presentation.

Choose Save As.

. At the bottom of the window for the Save as type, select JPEG (*.jpg).

Click Save.
At the next window asking what to export, click Every Slide.
A folder will be created with each slide appearing as an image.

Quit PowerPoint®,

Create a Slideshow Activity in Create Online

1.

8.

9.

Click on the Activity icon ® in the Create Online toolbar.

O
A
[

B

Select Slideshow ( - ) to open the Slideshow editor.

Click the New slides with images icon (o)

Click Select File.

Select the folder with the slide images you created earlier. Click Open.
Confirm the slide(s) order.

Move your cursor over a slide and click Edit.

Add alt text for the image(s).

Click Back.

10. Click OK to close the Slideshow Activity window.
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Save as Rich Text Format

You can save text from your PowerPoint® file into a file with a Rich Text Format. Then you
can copy text from this file.

1.

In PowerPoint®, choose File/Save as (or go to the ball in the top left corner of your
PowerPoint® window and choose Save as/Other Formats).

From the Save as type drop-down menu, choose Outline/RTF.
Click Save.

Notice that you have two files -- your original PowerPoint® file and your new file with
the extension .rtf.

Double-click on your new .rtf file. It should open in Microsoft Word.

In Word, copy all the text. [You can select all the text using (Ctrl+a) and then copy
the text.]

Start Create Online and choose Edit/Paste.

Save as a Viewable File

The following method allows students to bring up the PowerPoint® presentation within
PowerPoint® in a Read-Only mode. However, with this method, students can choose
File/Save As to save the presentation with another name on their computers.

1.

In PowerPoint®, choose File/Save As (or go to the ball in the top left corner of your
PowerPoint® window and choose Save as/PowerPoint Presentation).

At the drop-down Save type as menu, choose PowerPoint® Show (.pps). For
PowerPoint® 2007 users, we recommend that you NOT choose the .ppsx version for
compatibility reasons with older web browsers. Choose PowerPoint 97-2003 Show

(.pps).

In SoftChalk Create, select some text that you want to use as the hyperlink to your
PowerPoint® file.

Choose Insert/Hyperlink.
Click Select file and navigate to your PowerPoint® file .pps file.
Once you've selected your file, click Open.

If you want your students to view the PowerPoint® file in a new browser window,
then select the checkbox Open the link in a new window.

Click OK to return to your main lesson window.
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9. Choose File/Save.

When you save your lesson, SoftChalk automatically places a copy of the linked
PowerPoint® viewable file into your lesson folder. That way, when you are ready to
move your lesson folder to another computer or package your lesson all the files are in one
folder.

Save Images in a Word File

You can publish your PowerPoint® slides as images (with a .jpg format) into Microsoft
Word. Then you can copy and paste these images from Word into your SoftChalk

lesson. Since you are converting the images rather than the animation, no transitions or
effects from PowerPoint® will appear in SoftChalk.

This publishing method allows you to copy and paste the text for the notes.

1. In PowerPoint®, open your slide show. Choose File/Send To/Microsoft Word. In
PowerPoint® 2007, choose the ball in the top left corner of your PowerPoint® window
and choose Publish/Create Handouts in Microsoft Office Word.

2. Choose Notes below slides if you want to have the largest size images.

3. Click OK. PowerPoint® converts each slide to a jpg file and then automatically opens
a Word document and places each of the slide image files into the Word document.

4. In Word, copy all the text. [You can select all the text using (Ctrl+a) and then copy
the text.]

5. Start SoftChalk Create and choose Edit/Paste. All the slide images and notes will be
pasted into your SoftChalk lesson for further editing and enhancement.

Help

Please visit our SoftChalk Support webpage. For purchase information, please contact
sales@softchalk.com.

Copyright Information

SoftChalk™ Cloud
Copyright ©2002 - 2022
SoftChalk LLC

All Rights Reserved.
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